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Инструменти в InDesign

Всеки един инструмент си има своя икона. Освен 
с кликване на мишката, можете да избирате 
инструменти и със съответната клавишна комбинация. 

Начини за показване  на кутията с инструменти. 

• Фабричен – традиционна двойна колона. 

• Избирайки - Preferences > General (ctrl+K) се сменя 
начина на показване на колона. 

В по-новите версии на InDesign (CS5), промяната става 
и като кликнете върху двете малки стрелки, намиращи 

се в най-горния край – така е и в Illustratror 
и PhotoShop.
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Control Bar – контролен панел

При повечето инструменти, които избирате се 
появява контролен панел, на който имате 
следните опции:
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1. Reference Point (Предпочитана точка)

Показва спрямо коя част от обекта ще се извършва 
действието – център, горно дясно, средно дясно, 
долно дясно, горно ляво, средно ляво или долно 
ляво. Избраната точка е маркирана с черно.

2. X и Y положенията.

Показва положението на обекта спрямо 
координатите Х и Y. За нула се приема горния ляв 
ъгъл на страницата, а когато са две или повече 
страници – на най-лявата. Обърнете внимание, че 
координирането на обекта е спрямо точката, 
която сте избрали. 
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3. Width и Height (широчина и височина)

Променя се широчината и височината на 

обекта (внимание ако сте избрали 

инструмента за маркиране ще променяте 

само размерите на рамката, но не и на 

обекта.). И тук промяната е спрямо 

избраната от вас точка.

4. Constrain Proportions за Width & Height

Активирайки тази опция, ще зададете 

симетрично увеличаване или намаляване 

на обекта (рамката).
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5. Scale X и Y Percentages

Променят се размерите (на обектите, а 

не само на рамките) в проценти. 

Промяната на размера ще става 

спрямо избраната точка.

6. Constrain Proportions For Scaling

Пропорционално преоразмеряване и 

обратно.
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7. Rotation и Shear X Angles. От тук можете да 

завъртате или наклонявате обектите. Мерна 

единица е ъгъла. 

8. Stroke Size и Style (Рамка–стил и големина). 

Избира се големината и вида на рамката.

9. Object Style (Стилове на обектите)

С двойно кликване на мишката върху 

иконката, можете да създадете нов стил или 

с единично кликване да изберете 

съществуващ от падащото меню. 
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10. Quick Apply (Бърза настройка)

Можете бързо да намерите желаната 

настройка със зададен стил – буква, 

параграф или обект. 

11. Clear Attributes Not Defined By Style. 

Изчиства настройките, които не са 

зададени чрез стил.

12. Clear Overrides. Премахва всички 

настройки от даден обект.

13. Go To Bridge. Свързва с Adobe 

Bridge бразузера, който се инсталира 

заедно с Creative Suite.
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14 Control bar pull-down menu. От подменю се 
задават специфични опции за избраният от 
вас инструмент.

15 Palette toggle. Скрива или показва 
палитрите с настройки според избрания от 
вас инструмент.

16. Number of Columns. Брой на колоните в 
текста.

17. Text alignment (Текстово подравняване):
– Align Top – изравни отгоре;

– Align Center – изравни в средата;

– Align Bottom - изравни отдолу; 

– Justify Vertically – изпълни вертикално.
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18. Fit Frame to Content (Нагласи рамката по 
съдържанието). Нагажда маркираната рамка по 
съдържанието. 

19. Object alignment (Подравняване на обектите)

20. Select Container или Content (Избери контейнера 
или съдържанието). Маркиране на рамката на 
изображението или самото изображение.

21. Select Previous или Next Object in a Group

Тази икона се активира, когато сте маркирали 
обекти в група. Чрез нея можете да маркирате 
всеки един от групираните обекти поотделно.
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22. Fitting. Настройки на положението на рамката 
около обекта .

• Fit Content To Frame – запълни съдържанието по 
рамката (без да се запазват пропорциите);

• Fit Frame To Content - оразмери рамката по 
съдържанието. Ако обектът е по-малък от 
рамката то рамката ще се разгърне;

• Fit Content Proportionately – запълни 
съдържанието пропорционално;

• Fit Frame Proportionately – свий/разгъни рамката 
пропорционално 

• Center Content – центрирай съдържанието и 
рамката.
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1. Инструментите Frame Tool

Рамките (Frames) са основата при създаването на 
страници с InDesign. Всички илюстрации, 
снимки, графики, текстове са разположени в 
подобни рамки (контейнери). Не е необходимо 
предварително да създавате рамката, тя се 
създава автоматично. 
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2. Инструменти Shape Tool

С тези инструменти подобно на Frames 

Tool се създават фигури, които също 

могат да се превърнат в контейнери.
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4. Инструмент Scissors

За да изрежете точка/и от пътечка 

първо трябва да сте маркирали 

обекта с Direct Selection tool.
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3.Инструмент за чертане на линии Line Tool

Могат да се чертаят  прави, хоризонтални линии, 
вертикални линии или прави линии под ъгъл. Ако 
искате вашата права линия да е точно на 45% 
натискайте клавиша Shift докато чертаете.
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5. Инструмент Button tool. Button tool, служи 

за създаване на интерактивни елементи.

Могат да се задават различни настройки за 

интерактивния елемент (бутона). Има избор 

между различни положения на мишката 

(Mouse Up, Mouse Down, и др..) и различните 

видове връзки (номер на страница в 

документа, линк.. ).
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6. Инструменти за писане Type Tools.

От контролния панел се задават различни настройки –
промяна на шрифта,  на неговата големина, на 
разстоянието между буквите и думите, на 
подравняването и др.

7. Инструмент Eyedropper (Пипетка).

Служи за избиране на цвят от снимка, заливка от един 
върху друг обект.
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8. Инструмент Measurе

Този инструмент е заедно с палитрата Info и дава 

възможност да се получи информация за изчисляване 

на размера и ъгъла на обектите.



доц. д-р инж. Слава Йорданова 19

9. Инструмент Rotate.

Освен рамката (контейнера) е възможно да се 

върти и съдържанието, без рамката.
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10. Инструмент Shear

С този инструмент можете да накланяте графики, 

рамки, фигури, пътечки, линии, таблици, групи от 

обекти и т.н.
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11. Инструмент Free Transform. Извършват се 
различни трансформациии само със 
съдържанието. Разликата тук е, че въртите или 
преоразмерявате без осева точка.
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12. Групата инструменти Pen (писалка)

Тази група от инструменти служи за създаване на 
векторни рисунки. 

13.Можете бързо да промените размера нa рамката и 
съдържанието от Scale X и Y Percentages.
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Direct Selection и Position Tools - Инструменти за 
директно маркиране и позициониранe.

1.Инструментът Direct Selection се използва, когато 
трябва да се променя, размества или извършва 
някакво действие със съдържанието в рамката. 

2. Position tool - инструмент служи за „cropping” 
изрязване на снимките в рамките. Използва се за 
разполагане на снимки в контейнери, но не се 
променя формата на рамката. 

3. Промяна на мерните единици: 
Edit>Preferences>Units&Increments и в полето 
Ruler Units на Horizontal и Vertical избирате 
желаната мерна единица, от падащото меню.
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Изображение в мрежа
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Подготовка

1. Първа стъпка  - създаване на нов документ или 

отваряне на файл, върху който искате да работите. 

2. Втора  стъпка – създаване на  мрежа. За да стане това 

има няколко варианта.

▪ С Rectangle frame tool начертайте правоъгълник с 

големина по ваш избор.
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• От Object > Fitting > Frame Fitting

Options се задава Сrop Amount.

• От Window > Automationсе избира

палитрата Scripts. От диалоговия

прозорец се избира скрипта "MakeGrid”.

• Кликвайки два пъти върху името на

скрипта (или натискайки бутона Run

Script) се отваря диалогов прозорец.

Задават се следните настройки - брой

редове, брой колони и разстоянията

между редовете и колоните. Задава се и

Frame type.
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Мрежата е готова.
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Вмъкване на  картинки
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• Маркират се всички рамки със Selection Tool, след
което се избира - Object > Paths > Make Compound
Path.

• Появява се X. Чрез Place вмъкнете снимката. С
помощта на Direct selection tool можете да
настройвате големината и положението на снимката.
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Как да намерим перфектния 

цвят

Как да открием цветовата палитра скрита в нашата 

фотография? 

Цветът е този, който привлича внимание, задава 

настроение, предава послание. Цветовете  се виждат 

винаги в комбинация с други цветове. Затова и всеки 

дизайн, който създаваме се базира на цветовете във 

всеки елемент на страницата.

Пример: Дизайн на първа страница на каталог. Имаме 

дадена снимка.
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Целта е да изглежда свежо, живо, да носи усещане за 

сериозност и актуалност.
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При нормален изглед (100%) се виждат 
няколко основни цвята – червена коса, 
сини очи и сако, ако обаче увеличим –
виждаме стотици. 

• Първата стъпка е да намалим техния 
брой. 

• Трябва да се направи копие на слоя с 
изображението (така, че да не загубите 
оригинала), тогава се избира  
Filter/Pixelate/Mosaic. 

• Големият размер на клетките (Cell size) 
дава възможност да се видят няколко 
цвята. 
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• Изваждаме цветовете.

• С пипетката (eyedropper tool) вземаме проба от 
цветовете. Започваме от тези, които са в най-голямо 
количество.

• Избираме тъмни, средни и светли тонове от всеки 
цвят, за да получим контраст. 

• Запазваме цветовете в наша цветова палитра, като ги 
сортираме – по цвят и по тон (от светли към тъмни 
тонове).
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Изпробваме всеки цвят. Поставяме снимката в рамка от 

всеки цвят. Всички комбинации ще изглеждат добре, 

защото използваните цветове присъстват и в 

изображението. Можем да направим разграничение на 

цветовете:

▪ Tопли цветове (warm colors) – розово, кафяво, 

оранжево. Те правят изображението по нежно.

▪ Студени цветове (cool colors) – синьо(основно). 

Подходящи за по-сериозни, бизнес-ориентирани, 

директни послания.
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Добавяне на още цветове. Избираме някой от цветовете и 
намираме неговата област в цветовия кръг (color 
wheel). Целта на цветовия кръг е да покаже връзките 
между цветовете. Нека изберем синия цвят. Ще го 
наречем базов цвят.

Той е подходящ за снимката. Сега трябва да намерим 
цветове, които си подхождат с него. Трябва да се има 
предвид, че ако в дизайна има шрифтове и други 
графични елементи, ще имаме нужда от тъмни и 
светли тонове за контраст. Цветовият кръг е само за 
ориентир. Той представя теоретичната подредба на 
цветовете. Нашият син цвят няма на 100% да отговаря 
на синьото от кръга като състав.
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Създаване на цветови палитри. От базовия цвят, вече 
можем да създадем поредица от координирани 
цветови палитри. Например, бледо-синьото стои 
добре с тъмно виолетово и със синьо-зеленото.

Монохромна цветова палитра (monochromatic) – тъмна, 
средна и светла стойност на базовия цвят. Липсва 
дълбочина на цвета, но дава възможност за създаване 
на контраст, което е важно за добрия дизайн.
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Сходни (съседни) цветове (analogous) – една стъпка 
встрани от базовия цвят са неговите сходни цветове. 
Например – синьо-зелено, синьо, синьо-виолетово. 
Имаме хармоничност на цветовете, но слаб конраст.
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Допълващи се цветове (complement) – цветове, намиращи 
се на срещуположни страни в цветовия кръг. Например 
оранжево и синьо. Допълващите се цветове осигуряват 
контраст. Придават усещане за енергичност, сила, 
убедителност, вълнение. Обикновено се използват в 
малки количества като акцент. Например оранжева 
точка на синьо поле.
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Разделно допълващи се цветове (split complement) –
комбиниране на базовия цвят с двата цвята, които 
стоят встрани на неговия допълнителен цвят 
(неговите сходни цветове). Силата на тези цветове, е 
в слабо контрастната хармония на сходните цветове, 
плюс акцента на противоположния цвят (в случая 
синьо).
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Комбинация от допълващи се и сходни цветове – нежни, 
топли цветове и силен контраст със студения базов 
цвят от другата страна. Получава се вълнуваща и 
напрегната комбинация.
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Комбинация от сходни и допълващи се цветове –

сходните цветове на нашия базов цвят, създават 

студена цветова хармония, в която акцента е горещия 

допълващ цвят. Обикновено, точно 

противоположните цветове не пасват много добре 

помежду си, но можем да използваме техните 

нюанси. Например – тъмно син и светъл нюанс на 

оранжевия цвят.
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• Вариант I. Делово. Синьото и оранжевото присъстват в 
снимката и създават естествен контраст. Красиво и 
делово.

• Вариант II. Сериозно – тази палитра започва с тъмно 
червено от косатa и за акцент може да се използва 
нюанс оранжево. Сериозно, топло, притеглящо. Очите 
изглеждат зелени. Цветът на текста в светло оранжево 
дава нежен контраст
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Вариант III. Чувствено – светлите акценти от косата 
заливат страницата; Синият акцент дава контраст и 
дълбочина. Интерес предизвикват жълтите букви, 
които изглеждат като изрязани в снимката. 
Въздействащо и завладяващо, но само смел клиент би 
го избрал.

Вариант IV. Непринудено – цветове сходни на базовия син 
цвят. Зелен и синьо-виолетов цвят неприсъстващи в 
изображението. Имаме дълбочина, жизненост, 
посланието е по-достъпно и насочено.
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Вариант V. Приятно – синьо-виолетов цвят, отново 
неприсъстващ в изображението. Тук лицето, косата и 
фона са по-сходни. Синьо-виолетовият цвят е студен 
цвят, обикновенно свързан с нежността, женствеността, 
младостта, пролетта.
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Край


